Word Processing Introduction

There are three essential processes involved in creating any document using a word processor: writing, editing, and formatting your document. Most documents you will also want to print out or send to someone using e-mail or fax software.

Getting words on ‘paper’

How do you get your words on paper – or, more correctly, on screen?

You start by opening your word processing program, then opening your new or saved document and typing.

Almost all word processors start by presenting you with a blank document when you open them. If you don’t have a blank document open, you can create one by clicking the File Menu and choosing New from the menu.

The File, New option may give you a choice in the type of new document you create. Simply choose ‘blank’ document or ‘start from scratch’ or a similar option – the exact wording is different from one word processor to the next.

The insertion point

With a blank document open, you’ll see there’s a flashing vertical black line near the top of the document. This is called the ‘insertion point’, and it indicates the position where text you type will appear in the document. Because this is a blank document, it’s right at the top of the page. As you type, you’ll notice the insertion point moving to indicate where the next text you type will appear.

Type in a paragraph to test things out. If you’ve had experience using a typewriter, there are two things to keep in mind when using a word processor: 

There’s no need to hit the Enter key (occasionally labeled Return on some computers) until you come to the end of a paragraph. The word processor will automatically ‘wrap’ the current line round onto the next line, adjusting to the margin setting.

You do not need to add two spaces after a period for most text fonts. Unless you are using a font in which all the letters and characters have the same spacing, like Courier on an old typewriter, use just one space. Your text will be more readable, and will look more professional. 

A test paragraph

Try typing the paragraph below, and observe how the word wrap feature works and how your words appear in the word processing window. Don’t worry if you make spelling mistakes or other errors. You can go back and correct those later.

If you’re not familiar with typing on a keyboard, to capitalize a letter, hold down the left or right Shift keys and press the letter; to capitalize a string of letters, press the Caps Lock key once, type the letters, and then press Caps Locks to return to lowercase.


Here’s the paragraph:

Enclosed are the PC forms you requested for filing a pothole complaint with the township. Please sign each form, make 3 copies, and keep one of the copies for yourself. 

Once you’ve finished typing the paragraph, press Enter to begin a new paragraph.

Save Early, Save Often

Now that you've typed a paragraph, this is a great time to save your work for the first time. To save it, click the Save icon in the toolbar or open the File Menu and select Save.

When you save the document, you’ll give it a name and when you return to the word processing window, you’ll see the name in the title bar at the top of the screen.

Editing the text

Let’s try editing the text. Not everyone knows what PC means in the typed paragraph, so we’re going to insert the words ‘Pothole Complaint’ in parentheses after PC. 

To do that:

1. Use the arrow keys to move the insertion point so it’s positioned immediately after the ‘C’ in PC. (You may need to press the Num Lock key if you find the arrow keys are inserting numbers into your document instead of moving the insertion point.)

Most word processing programs will let you move the insertion point faster if you hold down the Control key (usually labeled ‘Ctrl’) at the same time as you press the arrow keys. Standard shortcuts are Ctrl-Left Arrow or Ctrl-Right Arrow to move the insertion point a word left or right at a time; and Ctrl-Up Arrow or Ctrl-Down Arrow to move to the beginning or the end of a paragraph, or the beginning or end of a page. You’ll also find the PgUp and PgDn keys will move you quickly from top to bottom of a screen, once you’ve typed a little more.

2. Once you have the insertion point positioned, type: (Pothole Complaint)
Writing more

Continue typing another two paragraphs, pressing Enter at the end of each paragraph, but NOT at the end of each line:

I am sorry to hear that your potholes are so large. Usually our crack team of pothole fillers notice the problem long before cars begin disappearing in them.

Please accept our apologies for taking five months to respond to your initial request. The pothole problem has been widespread this winter and we've had an unusually long list of requests for road repair.

Inserting text

It appears we’re writing a letter, but we’ve omitted the salutation at the beginning. To insert that, use the arrow keys to move the insertion point to the very beginning of your document.

You’ve already seen how easy it is to insert words. Inserting a new line or paragraph is just as simple: make sure the insertion point is positioned immediately before the first word in the first paragraph and then press the Enter key. The whole paragraph will move down one line. You can then press the Up Arrow key once to move up to the blank line you inserted, and type:

Dear Mr. Johnson,

If you find you accidentally insert too many blank lines, press the Backspace key to delete the extra blank lines and move your insertion point upwards. (Note: the Backspace key deletes characters to the left of the insertion point; the Del or Delete key deletes characters to the right of the insertion point.)

Now, use the Down Arrow key or PgDn key to go to the very bottom of your letter. If the insertion point won't move past the last word in the final paragraph, press Enter to move onto another line.

Type:

Sincerely,

Felicity Sluggaboom

Fixing mistakes

You’ve finished the core of your letter. It’s now time to read through and correct any mistakes.

Before you read through, you might want to use your word processor’s spelling checker to correct any spelling mistakes you've made. Each spelling checker works a little differently (and simple word processors don't even have one). There should be an icon for the spelling checker in the toolbar, or you'll find it as an option in an Edit, Tools or Proofing Menu.

Cleaning up after the spelling checker

Don’t depend on the spelling checker to catch all your mistakes. For example, in the second paragraph you might have typed ‘strait’ instead of ‘straight’. The spelling checker won't pick it up, as ‘strait’ is a word in its own right. A grammar checker should pick this up, but using a grammar checker on a short, informal document like this is probably overkill (and, besides that, they’re not always accurate!).

You can turn ‘strait’ into ‘straight’ by using the arrow keys to position the insertion point immediately after the ‘I’ and typing ‘gh’. An easier way to do the same thing is to use the mouse to move the insertion point: simply click immediately after the ‘I’ and then type ‘gh’. You’ll find there are almost always two or three ways to perform the same task in a word processor – choose the way that suits you best, but remember to look for the shortcut routes.

Editing alternatives

Notice how, in the second paragraph, you used the word ‘cars'. Most potholes aren't so big, so let’s change the word ‘cars' to ‘small pets'.

Here are three ways to do the same task:

1. Position the insertion point immediately after the word cars (using the mouse or arrow keys), press backspace four times to delete the word, and then type ‘small pets'.

2. Position the insertion point immediately after the word cars, hold down the Ctrl key and press Backspace to delete the word in one go, and then type ‘small pets'.

3. Double-click on the word cars to highlight (also called ‘selecting’) the word. Now, type ‘small pets'. The words you type will replace the highlighted selection.

You can use any of these techniques (they should all work in any word processor), but the third technique is the fastest.

Selecting text

The technique of selecting text mentioned in point three above is very important in word processing. At times, you'll want to select a single word. Other times, you may want to select a sentence, a paragraph or a whole document.

The standard text selection procedures are the same in nearly all word processors: double-click a word to select it; or click-and-drag over text to select a whole series of words, lines or paragraphs.

Other selection options vary between word processors. For instance, you can select a whole paragraph in Microsoft Word or WordPad by triple-clicking anywhere in the paragraph. 

Saving, Again

Once you’ve read through your document and made all the changes necessary, save your document once more.

Our letter doesn’t look much at the moment, but we’ll go into formatting shortly. Right now, you’ve learned the basics of creating a new document, typing in text, editing your work to correct mistakes and make changes, and saving your work.
Selecting Text

Becoming familiar with selecting text is crucial to making any changes to your document, whether those changes are editing or formatting (changing the look of the document): first you select the text, then you replace it, cut it, copy it, move it, delete it, or change its appearance.

We've already covered the basics of selection in the last article: you click and drag across text to select any amount of text, from a letter to a whole document; double-click a word to select it. Each word processing program has additional shortcuts for selecting anything from a sentence to a paragraph to an entire document.

Disappearing text

One of the most important things to remember is that if you have text selected in your document, typing anything on the keyboard will replace the selected text. This is one of the traps that catches beginners all the time.

For example, say you select the first paragraph in your document, planning to move it down below the second paragraph. Before you get a chance to do that, you accidentally tap the Spacebar. Your first paragraph will disappear, replaced by a single space. It’s no big deal as long as you keep your wits about you: just click the Undo icon or choose Undo from the menu. Watch out for this – it’s easy to select some text and then type something without realizing you’re replacing existing text.

Watch for the highlights

This works in nearly any Windows or Mac application and in dialog boxes as well, so take notice of it. If you have a dialog box in front of you, notice if any text is selected (highlighted). If it is, there’s no need to hit Delete or Backspace to get rid of it, just go ahead and type.

Equally important, if you don’t want to replace the selected text you need to click somewhere in the document or dialog box to deselect the text. (Clicking in a blank space on your page is a useful trick not only for deselecting text but also for closing a menu you’ve accidentally opened.)

The Clipboard

A lot of the changes you’ll make to documents will involve deleting, copying and moving text. Both Windows and Mac provide a feature to do this, and it's called the Clipboard. The Clipboard is a space in your computer’s memory for storing data (slabs of text, spreadsheet figures, graphics) temporarily.

Try this:

1. Open a document.

2. Write three or four sentences.

3. Highlight the first sentence and choose Cut from the Edit menu (or click the Cut icon in your word processor’s toolbar).

The sentence will disappear from your document.


4. Now, click immediately before the third sentence to position the insertion point there and select Paste from the Edit menu, or click the Paste icon on the toolbar.

The sentence you deleted will reappear at your insertion point, moving the third sentence over to make room. Check that there’s still a space between the sentence you inserted and the third sentence: you may need to insert a space manually, although some advanced word processors are smart enough to do this for you.

This is the usual process for moving text in a document. You:

· Select the text

· Cut it

· Move the insertion point to the new position.

· Paste the text.

If you want to copy a piece of text instead of moving it, use Copy and Paste instead of Cut and Paste.

Where’d the text go?

The text you cut is placed on the Clipboard, available to be pasted anywhere in your current document, another document or even in another program altogether. The Clipboard holds one item at a time: anything you cut or copy to the Clipboard will remain there until you cut or copy something else. This means you can Cut an item to the Clipboard and then Paste it multiple times.

Remember, you have to use the Cut or Copy commands to place text on the Clipboard. If you highlight some text and press Delete or Backspace to delete it, the text will not be placed on the Clipboard, it will simply disappear.

Moving and copying text

You can probably see how useful Cut, Copy and Paste can be in restructuring a document. These commands are also terrific for moving or copying information between documents. Because you only have one Clipboard for all the applications you run, anything you copy to the Clipboard from one program will be available to almost any other Windows program. So, for example, one way to place a graphic in your word processing document is to:

· Open a graphics program and create a graphic.

· Select the graphic and Copy it to the Clipboard.

· Open your word processing program, position the insertion point and click the Paste button.

Similarly, you can copy text from one document to another by opening the first document, selecting the text, clicking the Copy button, opening the second document, positioning the insertion point and clicking Paste.

Dragging and dropping

Cut, Copy and Paste are great techniques to master because they are universal. Once you learn these techniques, you can use them in almost any program.

If you want to be more efficient, most word processors offer an even simpler technique for moving of copying text within a document: drag and drop. With drag and drop you don’t need to use the Clipboard. Instead, you:

Select the text you want to move.

Position your cursor so it’s within the selected text. The cursor will usually change shape – to an arrow-head pointing towards the left margin in Microsoft word processors.

Hold down the mouse button and drag the text to its new position, then release the mouse button.

Simple, huh?

If you want to copy the text rather than move it, hold down the Ctrl key while you click and drag the text.

Dragging between applications

In many processors, this process of drag and drop even works between applications.

For instance, you can open up your word processor and, say, your e-mail editor, right-click in a vacant space on the program's Taskbar and choose Tile Vertically or Tile Horizontally to position both windows side by side, and then click and drag selected text (or Ctrl-click and drag it to copy it) from one window to another.
Formatting

The first step in formatting text is selecting the text you want to format. Decide which text you want to change, select it, and then apply the appropriate formatting. 

Some formatting is applied to your whole document (such as page margins), but most is applied to specific portions of text.

You’ll find most essential formatting tools on your word processor’s toolbars and the ruler. Formatting controls include:

· Bold, italic and underlined text

· Alignment tools (left, centered, right, and justified)

· Font size and typeface 

· Indentation

· Tab settings

· Margin settings
Carry over formatting

When you start a document, you can format the first paragraph, and then have that style carry over for the rest of the document, including margin indents, typeface and so on.

You can check the formatting on particular paragraphs by clicking in differently formatted paragraphs in your document: you’ll find that the ruler and toolbar icons change to reflect the formatting of the current paragraph. The ruler will show the tab settings and indents for the current paragraph; toolbar buttons such as the alignment buttons will be selected if they’re currently in effect.

Pre-designed styles

If you’re really wanting to make a good impression and don’t trust your own judgement, you’ll find most of the good word processors come with a range of pre-written templates (aka wizards, experts, tutors and various other names). You can use these templates as guidelines for creating your own letters.

Even if you want to do your own work from scratch, taking a look at some of these templates will give you an idea of what’s possible and what makes good formatting sense.

Avoid the Enter key

One common error is to space paragraphs by pressing the Enter key twice. There’s no need to do this. The word processor provides a more elegant way that gives you much better control over the look of your document.

To space paragraphs using (almost) any word processor, use this method:

Type your document, pressing Enter once at the end of each paragraph.

Select all the paragraphs in your document and then use the Format Paragraph option to adjust the spacing after each paragraph. 

For example, in Microsoft Word, open the Format Menu, choose Paragraph, and then adjust the Spacing After to 6 points. 
 
You’ll find similar options in other word processors.

Avoid the Spacebar

A second common error in the way people use word processors is to align text by using the Spacebar, instead of using tab stops or ruler settings.

Beginners often line up columns by typing a word, pressing the spacebar multiple times to position the next column, typing the next word, pressing the spacebar again and so on. On the next line, they try to align words under the existing text by repeatedly pressing the Spacebar again. 

Take a look at the text in the following screenshot:
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See how the text contains a list of items, neatly aligned in columns? Those little L's in the ruler are tab settings, and they line up the text neatly and can be quickly changed for all the columns at once.

Proportional and monospaced typefaces

Most word processing typefaces are proportional , meaning each character is a different width (contrast this with monospaced typefaces, where each character – such as M and I – occupy the same width).

For example, contrast the word "smile" in the proportional Times New Roman font with the same word printed beneath in the monospaced Courier New font:

smile    
smile

See how each character is a different width in the proportional font? This makes the proportional font very space efficient, compared to a monospaced font. But it also makes it difficult to line up proportional fonts by typing spaces. So, use the tab settings!

The ruler

Word processors offer a quick, neat way to align text using tabs. In most word processors, you have enormous control over tab settings, allowing you to create aligned text very rapidly.

Most word processors have a ruler which lets you set indentation, margins and tab settings. You’ll usually find it situated near the toolbars at the top of the page.

The ruler, like the toolbars, provides single-click shortcuts to controlling the most common elements of paragraph indentation and tabs. If you need additional control, you’ll need to check out options on the Format or Text menus, which will give you greater control.

Using the ruler

Use tabs when you want columns of words or numbers to be aligned. You can also use tables to do this task, but not all word processors support tables, and tabs are usually less complex to work with.

To use the ruler, first select the paragraph(s) you want to format, then make the appropriate adjustments to the tab settings, indents and margins. You can then select another paragraph and apply a different group of settings if you wish.

Have a look at the screenshot below. It’s similar to the previous screenshot, but highlights the features of Microsoft Word’s ruler. While not all word processor rulers are the same, you’ll get a good idea of what’s possible by examining the Word ruler.

Figure 2. Features of the Microsoft Word ruler
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A. Tab style selector: click to select between left-aligned, right-aligned, centred or decimal tabs.

B. Left indent marker: Click and drag to indent the second and subsequent lines in a paragraph.

C. Indent box: Click and drag to indent a whole paragraph.

D. First line indent marker: Click and drag to indent the first line of a paragraph.

E. Decimal tab: To position a tab, first use the tab style selector at the left end of the ruler to choose the type of tab you want, then click on the ruler to position a tab. The decimal tab is used to align numbers on their decimal point.

F. Left-aligned tab: This is the ’default’ tab style, aligning text flush left with the tab position.

G. Right indent marker: Click and drag to change the right indent of all lines.

H. Notice the first-line indent on the paragraph created by moving the first-line indent marker to the right on the ruler.

I. The numbers are aligned around their decimal points, in line with the decimal tab on the ruler.

J. This last column is left-aligned with the final tab placed on the ruler.

